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VISTA/WINDOWS 7  VOICE RECOGNITION 

TRAINING AT MEETING 

Windows 7 has many features designed to let the user 

interact with the desktop interface in place of the key-

board and mouse. One feature is touch, another is 

speech recognition. 

What is Speech Recognition? 

Just as the keyboard allows one to enter commands 

into the computer, and the mouse to deliberately 

change location where you want to type or to launch a 

file, speech is a new dimension of interface control 

that focus on commands, not location. 

 

What if an application does not present 

―commands‖?  It can still be controlled by overlaying 

numbers above the interface, a geography control. To 

activate a function one only needs to speak the num-

ber. A mouse grid can be used to relocate the mouse in 

the appropriate grid location. The grid has nine zones, 

and when a zone is selected, the mouse moves to that 

zone, and a new nine zone grid is created. The speaker 

speaks the number again and keeps repeating the proc-

ess until the mouse is put in the appropriate location. 

Rosemary Lloyd will conduct a training on how to set 

up Voice Recognition for those of you who have Win-

dows 7.  It‘s a fun program to set up and use on your 

computer. 
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EVERYONE TO PAY DUES IN JANUARY 
 

The 2011 Membership dues ($25.00 per per-

son) are now being accepted by the Big Bear 

Computer Club. Be sure to pay your dues by 

January in order to continue receiving the 

monthly newsletter.   You can pay your dues 

at the monthly meeting, or by mail to: Big 

Bear Computer Club, PO Box 645, Big Bear 

City, CA 92314; or by Pay Pal (Go into our 

website www.bigbearcc.org and go to 

―Donate‖.  This will take you to Pay Pal.) 

Please fill out form on page 13 and submit 

with your dues for renewal. 

http://www.windows7news.com/2009/09/18/how-to-use-speech-recognition-with-windows-7/
http://www.windows7news.com/2009/09/18/how-to-use-speech-recognition-with-windows-7/
http://www.bigbearcc.org
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Organizations, employers, school teachers, computer clubs, senior citizen centers, and a variety of other institutions are often 

in search of some type of topic or event that they can use as a theme for meetings and presentations.  For those looking for an 

October topic (but can really be done during any month), October has been declared by the president as National Cyber Secu-

rity Awareness Month. 

 Someone may ask, "Why even have a National Cyber Security Awareness Month?"  We all need to be aware of the 

risks involving our computers, and how those risks can impact us personally.  The news is rife with stories about viruses and 

malware, such as the recent massive attack by the "Here You Have" Trojan that wreaked havoc on millions of computers in a 

single day.  Identity theft and other economic cyber crimes are depriving individuals and businesses of billions of dollars every 

year.  Social networking websites are being utilized by pedophiles to lure thousands of children into dangerous, and even life 

threatening, liaisons with miscreants.  Hackers and crackers will frequently try to break into our home and office computers for 

malicious purposes, trying to steal our private information, or otherwise hijack our computers to send out spam email or launch 

coordinated cyber attacks on other computers.  Fraud of many types is rampant online, from phishing schemes designed to 

trick the user into giving his username and password to the crooks, to counterfeit products, get-rich-quick scams, political mis-

information, and  medical quackery.  According to several cyber security companies, spam emails constitute over 90% of all 

email hitting our servers.  As I type this, one security website has catalogued over 14 million different viruses, worms, Trojans, 

and other forms of malware just waiting to infect our computers, with literally tens of thousands of new threats appearing every 

day.  The average computer is unaware that we are currently engaged in an active cyber war, with foreign nationals hammering 

our government, military, and industrial computers looking for that hole that will grant them access to valuable informa-

tion. Cyber espionage, the obtaining of military secrets or classified industrial projects, is rampant. 

 So, why have a National Cyber Security Awareness Month?  While many of us are complacent, and compute with 

blissful ignorance, we are also all soldiers in the front lines of this battle, so we must first be aware of the threats, and then take 

appropriate actions to mitigate them. 

National Cyber Security Awareness Month was first implemented by a Presidential Order from President Bush in 2001. The 

president  declared that every October be National Cyber Security Awareness Month, a declaration recently ratified by Presi-

dent Obama.  For 2010, the program is under the auspices of "The National Cyber Security Alliance (NCSA), a public-private 

partnership focused on educating a digital citizenry to stay safe and secure online. NCSA, along with the U.S. Department of 

Homeland Security (DHS) and the Multi-State Information Sharing and Analysis Center, sponsors National Cyber Security 

Awareness Month."  While the Department of Homeland Security is the primary public agency promoting this activity, several 

private companies provide much of the funding and manpower used for this project.  These private companies include  AT&T, 

Cisco, General Dynamics, Google, Lockheed-Martin, Microsoft, Symantec, McAfee, Verizon, and Visa. Dozens of other com-

panies, organizations, governmental agencies, and colleges have publically endorsed the project, and are actively participating 

in its promotion. The NCSA has a "Get Involved!" website at www.staysafeonline.org/content/get-involved-1 where differ-

ent groups can get information on how to promote the event.   

            Specific resources and instructions are available for home users, educators, businesses, college students, college admin-

istrators, libraries, local law enforcement, and local government.  With the resources provided, these and other groups can eas-

ily present an audience appropriate presentation.  Posters, flyers, pamphlets, brochures, bookmarks, and other printed materials 

are available in both PDF and Word formats, such that the presenter will have little original work to prepare. 

            Customized examples of the content for each constituency are freely provided, and easy to use on the "Get Involved!" 

website. For example, home users are instructed to use a comprehensive security suite that provides frequent automatic up-

dates, update their operating systems and browsers as soon as patches are released, use complex passwords, be cynical about 

giving others your personal information online, turn off your computer when not in use, know that security applies to mobile 

devices (such as smart phones) just as much as it does to a computer, know the symptoms of a 

October is National Cyber Security Awareness Month by Ira Wilsker 

   Continued on Page  3 
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compromised computer, teach his children about online safety, backup his data frequently, lookup himself and family mem-

bers on the major search engines to see what is posted about them, and maintain vigilance  and awareness of contemporary 

threats. 

            Teachers and college faculty should encourage good cyber security practices every time their students are online, as 

well as integrate cyber security and safety into lesson plans and course content;  arrange for a competent cyber security pro-

fessional to speak to classes and parents;  incorporate cyber security and safety into faculty in-service training; require all 

students to change their password in October to one that is long, complex and not easy to guess.  It should not only be the 

teachers that should be involved, but administration needs to also be involved. The NCSA has resources for administrators 

as well, at www.staysafeonline.org/content/what-college-administrators-can-do. 

            Local law enforcement needs to be involved, as our citizens are often victimized by online criminals.  There is no 

net difference in the pain or loss suffered by a victim who has been robbed locally, or one robbed online.  Too many of our 

children are victimized by pedophiles who troll for naive children online.  Law enforcement should get on board with the 

program.  Local law enforcement are looked to for security guidance and protection from criminal activity; that protection 

should not just be the traditional protection from street crime, but should also include community education on protection 

from cyber crime.  Local law enforcement agencies should present cyber security topics at external community events, and 

internal training, including at roll call.  The distribution of cyber security literature should occur along with other crime pre-

vention literature.  Departments should implement a written policy on dealing with citizens who have been cyber victimized 

(such as Internet fraud or identity theft), and encourage them to report it to the FBI‘s Internet Crime Complaint Center 

(www.ic3.gov).  Appropriately trained and skilled officers should speak at local schools, businesses, religious institutions, 

and other organizations on cyber crime and cyber security; a police officer (or deputy sheriff) has a cache' of authority that 

many other speakers may lack. 

            Businesses, both small and large, have become the primary targets for many cyber thieves.  These crooks are utiliz-

ing a variety of ingenious online tricks and tools to defraud businesses, many of which can be mitigated if only the employ-

ees (and management) are appropriately trained, and proper policies are implemented.  Cyber security policies and proce-

dures need to be reviewed frequently, and updated as appropriate, as the threats are dynamic and constantly changing.  The 

NCSA and Symantec published a small business cyber security study which shows what businesses are doing 

(staysafeonline.org/content/2009-smb-security-study).  Hold periodic employee meetings, such as brown-bag lunches, 

where cyber security practices can be openly discussed.  Post security tips in break rooms, work rooms, and company news-

letters, as well as distribute handouts to employees.  Businesses need to create an environment where employees can freely 

raise security concerns.  Make sure that your customers and clients, including online customers, know that you are ade-

quately protecting their personal and private information.  Make it a policy that computers should be shut down at night and 

at other down times.  Managers need to be kept informed in a timely manner of any evolving security threats that can im-

pact the business. 

            Whatever the  event or group, there is an abundance of educational and training materials freely available for cyber 

security training. There is a large assortment of cyber security "Tip Sheets" available from staysafeonline.org/content/

ncsam-tip-sheets. These Tip Sheets, available for free in both PDF and Word formats, include documents about gaming 

safety for kids and parents, Internet Safety and Security Tips For Parents, Mobile Safety Tips, and Social Networking Tips 

2010    Under each of the groups listed at staysafeonline.org/content/get-involved-1 (home users, businesses, law enforce-

ment, etc.) are links to additional resources. Still more resources are available online at staysafeonline.org/content/

additional-awareness-resources-2010    While October is National Cyber Security Awareness Month, we need to make 

every day a security awareness day.  We lock our cars, and we lock the doors to our homes; we need to lock our computers 

as well to prevent others from accessing them and doing harm to us and others.      

 

Continued from Page  2 
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www.techbargains.com 

web site devoted to helping users find the best 

technology products and the lowest price 

 

 

Beginning Bank $2,649.03  

 

Cash Received $24.00  

Membership Dues $12.50  

Fundraising: Equipment $0.00  

Donations: 50/50 $11.50 

  
 

Total Income  $24.00 

 

Cash Disbursed $0.00  

Promotion $0.00 
 

Total paid out 

Ending balance in Bank $2,673.03  

Cash Flow – September, 2010 

 

 
User Group Discounts 

 

Get 40% off books from O'Reilly, Micro-
soft Press, No Starch, Paraglyph, PC Pub-
lishing, Pragmatic Bookshelf, Rocky Nook, 
SitePoint, or YoungJin books and 50% off 
ebooks you purchase directly from O'Reilly. 
Just use code DSUG when ordering online or 
by phone 800-998-9938 

http://www.techbargains.com
http://post.oreilly.com/rd/9z1zsj1n5rh32ffr3i3tti77mk656ems566k213llh8
http://post.oreilly.com/rd/9z1zsj1n5rh32ffr3i3tti77mk656ems566k213llh8
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Did you know that you can save a search string in Windows 7? It’s really helpful if you commonly 
search for one kind of item on your hard drive, so you don’t have to go typing it in every time. 
 
Here’s how you do it. 
 
First, open up Windows Explorer. You can either click Start>Computer, or type in Windows Ex-
plorer in your Search Box located above the Start button. 
 
In the upper-right had portion of the Windows Explorer window, you’ll see a box where you can 
type your search in. I typed in jpeg, to search for all the jpeg files on my computer. (obviously you 
can use your own search term). 
 

 
 

Once your results pop up, click the Save search button, which is located on the left side of the 
Windows Explorer window. 
 

 
 
Another windows will pop up and ask you to name your saved search. I just click Save. 
 
Now you’ll see your saved search under the Favorites section in the left column of Windows Ex-
plorer. You can click on it at anytime to automatically start your custom search! 
 

   www.worldstart.com/ 

 

 (Used by Permission - WorldStart, Inc)  

Save A Search In Windows 7 

 

GET  WELL WISHES 

Grace Fross  Eileen Bryan 

Nancy Hinz  Sharon Teeter 

http://www.worldstart.com


 6 

Big Bear Computer Club Bearly Bytes                                   October, 2010 

 

The following members have generously offered 

to help you with your PC problems by Phone or 

by email: 
 

Windows Beginners                  Yomar Cleary 

878-5622                      ycleary@charter.net 
 

Windows XP, Vista, 7             Rosemary 

Lloyd 

584 9358                 Rosemary@bigbearcc.org 
 

MS Outlook                           Rosemary Lloyd 

584 9358                 Rosemary@bigbearcc.org 
 

MS Excel                                Yomar Cleary 

878 5622                      ycleary@charter.net 
 

MS Publisher                               Yomar 

Cleary 

878 5622                     ycleary@charter.net 
 

Digital Photos                     Barbara Moore 

585 7981                    barbmoorebbl@gmail.com 
 

CD Burning                           Rosemary Lloyd 

584 9358                  rosemary@bigbearcc.org 

  

Adobe Photoshop,                   Rick Edwards 

Photoshop Lightroom   

547-0109                     rick235@charter.net 
 

The Computer Club provides train-

ing at the monthly meetings when 

there is no presenter. Beginners 

are welcome 2nd Tuesday of the 

month at the Discovery Center at 

5:30 pm. Bring a friend. Yearly 

dues are only $25, spouse is $5. 

First 2 visits are free!  

Helpline 

President......................................Rosemary Lloyd 

584-9358                    rosemary@sugarloafpc.com 

Vice President………………………..Yomar Cleary 

878-5622                                 ycleary@charter.net 

Treasurer........................................Barbara Moore 

585-7981                          barbmoorebbl@gmail.com 

Secretary………………….…..……...Tina Nazarian 

633-4516                     Tina_Nazrian@hotmail.com 

Reviews Editor………………..………....Ron Fross 

951.769.1225                          rgfross@yahoo.com 

Refreshments……………………….Sharon Teeter 

585-2026  sharonteeter1@verizon.net  

Publicity............................................Yomar Cleary 

878-5622                                 ycleary@charter.net 

Equipment Director...........................Don Odekirk 

585-6728                            djodekirk@hotmail.com 

Technical Director.................................Jim Lloyd 

584-9358                     inquiries@sugarloafpc.com 

2 Directors at Large…………..…..........Open                        

 

Webmaster........................................Bill Flanagan 

866-9379                                   bill@bigbearcc.org 

Newsletter Editor..............................Eileen Bryan 

714.580.4784                    eileenbrn6@yahoo.com 

Membership Director…………...…..Open 
 

Parliamentarian............................David Philipson 

585-9389             philipson@philipsonerdmier.com 

Historian..............................................Nancy Hinz 

585-8095                                   ncyhz@gmail.com 

Sunshine Coordinator......................Grace Fross 

951.769.1225                         gcfross@yahoo.com 

Name Tags—50/50…………………...Dorothy Sirk 

585-3449                 dorothymsirk@earthlink.com 

Officers and Key Leaders 
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President’s Message  

Rosemary Lloyd 

Hello Everyone 

Happy Fall! 

 

I just found another Smart Computing article that 

piqued my interest.  Do you get tired of typing on 

your computer?  Windows Vista and 7 come with 

Speech Recognition.   

It is a neat system that allows you to do virtually 

everything by talking to your PC, rather than typ-

ing.  Going through the Speech Recognition tuto-

rial helps you learn the commands to use.  At the 

same time, the computer learns to recognize your 

speech. 

Now, there is a substantial learning curve for me.  

I have just begun to scratch the surface.  I find that 

talking to the computer can be fun.  Speech Rec-

ognition in Windows is an exciting step towards 

the computer being easier to use.  We are not there 

yet.   

However, if you want to try something new, you 

can give this a go.  How?  Go to the ‗Ease of Ac-

cess‘ section in ‗Control Panel‘.  From there you 

can configure ‗Speech Recognition‘.  Pretty cool. 

 

See you soon! 

Thanks. 

Rosemary Lloyd 

 

General Meeting Minutes   

Tina Nazarian 

 

September 14, 2010 

General Meeting Synopsis 

 

The meeting began with a little business.  Rose-

mary introduced guests.  She mentioned the 

50/50 drawing and the club web site.   

We heard an update on the soccer team that the 

club is sponsoring.  They have a winning record 

with 2 wins and 1 loss, scoring 11 goals so far.   

We talked about the volunteers needed by the 

club.  Currently there are openings for Member-

ship Chair, Events Coordinator and 2 Directors-

at-Large. 

Those present broke into small groups for ad 

hoc training. 

We did the opportunity drawings. 

Finally, we stepped outside to observe the Inter-

national Space Station (ISS) as it flew over.  It 

looked like a bright star moving quickly from 

the northwest to the south southeast.  It was very 

cool! 

 

Submitted by Rosemary Lloyd 
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News Alert: Adobe Reader Flaw Appears in Flash  - 

By Kim Komanado  

About Bearly Bytes 

Bearly Bytes, past winner of SWUGC & APCUG 

Newsletter contests. is the official publication of 

the Big Bear Computer Club. Views expressed 

in Bearly Bytes are those of the authors and do 

not necessarily reflect the opinions of Big Bear 

Computer Club. Other computer user groups 

are welcome to reprint our articles as long as 

they give credit to the author and Bearly Bytes, 

Big Bear Computer Club. 

Submissions: All BBCC members are encour-

aged to send letters, articles, questions, and 

comments to Bearly Bytes for inclusion in future 

issues. Submit as plain text in the body of an 

email and attach any graphics as JPEG or GIF 

format. Send to Yomar Cleary 

 

 

 

 

Performance Management Software  

866-566-7778 

 

 
Adobe has just announced a new security flaw in Flash. The 

flaw is the same as the recent problem revealed in Reader. The 

Flash flaw won't be patched until the week of Sept. 27. And 

the flaw in Reader won't be patched until the week of Oct. 4. 

  

Until the patches arrive, there are few options to stay safe. 

You can use another PDF reader. Unfortunately, though, 

there isn't a good alternative to Flash. Adobe and Microsoft 

recommend trying Microsoft's latest                                                                                                                                                  

  

Enhanced Mitigation Experience Toolkit (EMET). This makes 

it easy to enable advanced security options in Windows. One 

of these options is turned off in Reader and Flash. 

  

The cause of the flaw is complex, but here's the short version. 

One of the Adobe files lacks Address Space Layout Randomi-

zation (ASLR) capability. This allows hackers to circumvent 

safeguards and run code. 

  

Activating ASLR for Flash and Reader can slow down hack-

ers. Note that ASLR is only available in Windows Vista and 7. 

XP users will have to wait for a patch. 

  

Download and run the EMET program. Click the Configure 

System button. Change the Profile Name to Maximum Secu-

rity Settings. Click OK. 

  

Now click the Configure Apps button at the bottom of the pro-

gram. Click the Add button. Then go to 

C:\Windows\System32\Macromed\Flash\. You will see at least 

one application (.EXE) file. Select that and click Open. Repeat 

this step for every .EXE file in that directory. 

  

Now click the Add button again. Go to C:\Program 

Files\Adobe\Reader 9.0\Reader\. Select the application file 

AcroRDd32.exe. Then click Open. Once this is done, click 

OK. Now restart your computer. Your system should be rea-

sonably protected. 

  

Now, it is important to note that Flash and Reader weren't de-

signed to work this way. You may encounter some problems. 

In that case, you will need to turn off ASLR. 

  

Open the EMET program. Click the Configure Apps button. 

Now select an application and click the Remove button. Do 

this for all programs. Click OK and restart the computer. Now 

select an application and click the Remove button.      — 

 

http://www.premiummemory.com/
http://www.halogensoftware.com/
http://www.komando.com/downloads/category.aspx?id=1666
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=c6f0a6ee-05ac-4eb6-acd0-362559fd2f04&displayLang=en#QuickDetails
http://www.offers.com/
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Understanding Bluetooth Technology—Authors: Mindi McDowell, Matt Lytle   
 

Many electronic devices are now incorporating Bluetooth technology to allow  wireless communication with other 

Bluetooth devices. Before using Bluetooth, it is important to understand what it is, what security risks it presents, and 

how to protect yourself. 

 

What is Bluetooth? 

 

Bluetooth is a technology that allows devices to communicate with each other without cables or wires. It is an electron-

ics "standard," which means that manufacturers that want to include this feature have to incorporate spe-

cific requirements into their electronic devices. These specifications ensure that the devices can recognize and interact 

with other devices that use the Bluetooth technology. 

 

Many manufacturers are making devices using Bluetooth technology. These devices include mobile phones, computers, 

and personal digital assistants (PDAs). The Bluetooth technology relies on short-range radio frequency, and any device 

that incorporates the technology can communicate as long as it is within the required distance. The technology is often 

used to allow two different types of devices to communicate with each other. For example, you may be able to operate 

your computer with a wireless keyboard, use a wireless headset to talk on your mobile phone, or add an appointment to 

your friend's PDA calendar from your own PDA. 

  

What are some security concerns? 
  

Depending upon how it is configured, Bluetooth technology can be fairly secure. You can take advantage of its use of 

key authentication see Understanding Digital Signatures for more information) and encryption 

(see Understanding Encryption for more information). Unfortunately, many Bluetooth devices rely on short numeric 

PIN numbers instead of more secure passwords or passphrases (see Choosing and Protecting Passwords for more infor-

mation). 

  

If someone can "discover" your Bluetooth device, he or she may be able to send you unsolicited messages or abuse your 

Bluetooth service, which could cause you to be charged extra fees. Worse, an attacker may be able to find a way to ac-

cess or corrupt your data. One example of this type of activity is "bluesnarfing," which refers to attackers using a Blue-

tooth connection to steal information off of your Bluetooth device. Also, viruses or other malicious code can take ad-

vantage of Bluetooth technology to infect other devices. If you are infected, your data may be corrupted, compromised, 

stolen, or lost. You should also be aware of attempts to convince you to send information to someone you do not trust 

over a Bluetooth connection (see Avoiding Social Engineering and Phishing Attacks for more information). 

 

How can you protect yourself?   

 

     * Disable Bluetooth when you are not using it - Unless you are actively transferring   information from one device to 

another, disable the technology to prevent unauthorized people from accessing it. 

     * Use Bluetooth in "hidden" mode - When you do have Bluetooth enabled, make sure it is "hidden," not 

"discoverable." The hidden mode prevents other Bluetooth devices from recognizing your device. This does not prevent 

you from using your Bluetooth devices together. You can "pair" devices so that they can find each other even if they are 

in hidden mode. Although the devices (for example, a mobile phone and a headset) will need to be in discoverable 

mode to initially locate each other, once they are "paired" they will always recognize each other without needing to re-

discover the connection. 

     * Be careful where you use Bluetooth - Be aware of your environment when pairing devices or operating in discov-

erable mode. For example, if you are in a public wireless "hotspot," there is a greater risk that someone else may be able 

to intercept the connection (see Securing Wireless Networks for more information) than if you are in your home or your 

car. 

     * Evaluate your security settings - Most devices offer a variety of features that you can tailor to meet your needs and 

requirements. However, enabling certain features may leave you more vulnerable to being attacked, so disable any un-

necessary features or Bluetooth connections. Examine your settings, particularly the security settings, and select options 

that meet your needs without putting you at increased risk. Make sure that all of your Bluetooth connections are config-

ured to require a secure connection. 
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Tab stops are a paragraph format. That means you can assign different tab stops for individual paragraphs. Fortunately, 

that doesn‘t mean you have to delete them all individually—or by the paragraph. There‘s a quick, easy way to delete all 

the tab stops in a document. 

 

First, select the entire document. There are a number of ways to do so, but the quickest is to press [Ctrl]+a. With the en-

tire document selected, do the following to delete all tab stops: 

1. Choose Paragraph from the Format menu. Or, right-click the selection and choose Paragraph from the resulting 

context menu. In Word 2007 and 2010, click the Home tab | Paragraph group Dialog launcher. 

2. Click Tab (at the bottom-left). 

3. In the Tabs dialog box, click the Clear All button at the bottom-right. 

4. Click OK. 

 

The truth is, deleting all the tabs is a simple enough task, but the feature‘s placement isn‘t particularly easy to find, in 

any version. Of course, you won‘t always want to delete all of the tab stops. You can clear individual tab stops as fol-

lows: 

1. Position the insertion point in the appropriate paragraph. 

2. Choose Paragraph from the Format menu. Or, right-click the selection and choose Paragraph from the resulting 

context menu. In Word 2007 and 2010, click the Home tab | Paragraph group Dialog launcher. 

3. Click Tabs. 

4. In the Tab Stop Position control, highlight the tab stop you want to delete. 

5. Click Clear. 

 

Some might consider using the ruler a bit easier: 

1. Position the insertion point in the appropriate question. 

2. Find the tab indication on the ruler and drag it off–it couldn‘t be simpler! 

 

As long as we‘re talking about the ruler, there are two quick ruler tips that I really like: 

1. Double-click an existing tab on the ruler to display the Tab dialog box for quick formatting. 

2. Double-click the ruler where you want to insert a tab to both insert a tab and open the Tab dialog box. 

USER GROUP COUPON CODE - Peachpit  
 

We provide your group members with a 35% discount off the list price of any of our books. At checkout, right before 

entering their credit card information, they must enter the user group coupon code UE-23AA-PEUF (case-sensitive). 

This coupon code is an exclusive offer that may not be used in conjunction with any other coupon codes.   

www.peachpit.com     

      
 
 

FRIDAY FREEBIES   Peachpit is doing weekly #Friday Freebies giveaways on Twitter. To participate, just follow 

@Peachpit & look for the weekly #Friday Freebies blog post at peachpit.com/blogs. They are giving away some great 

prizes - from books and videos to T-shirts and pieces of memorabilia. You can also partake in more fun over at the 

Peachpit Facebook fan page, at facebook.com/peachpitpress.  

 

How to Delete all Tab Stops in Word Documents by Susan Harkins 

http://app.streamsend.com/c/12620743/6804/J9xfFyL/W5GQ?redirect_to=http%3A%2F%2Ftwitter.com%2Fpeachpit
http://app.streamsend.com/c/12620743/6804/J9xfFyL/W5GQ?redirect_to=http%3A%2F%2Ftwitter.com%2Fpeachpit
http://app.streamsend.com/c/12620743/6806/J9xfFyL/W5GQ?redirect_to=http%3A%2F%2Fwww.peachpit.com%2Fblogs
http://app.streamsend.com/c/12620743/6808/J9xfFyL/W5GQ?redirect_to=http%3A%2F%2Fwww.facebook.com%2Fpeachpitpress
http://app.streamsend.com/c/12620743/6802/J9xfFyL/W5GQ?redirect_to=http%3A%2F%2Ftwitter.com%2Fpeachpit
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Word Tip 

By  Rosemary Lloyd 

Excel Tip 

By Yomar Cleary 

Window  Tip 

By Barbara  Moore 

 

TURNING OFF ERROR MARKING 
 

Word includes handy spelling and 
grammar checkers that can take 
the hard edges off some of your 
writing. Sometimes, however, it is 
nice to turn those features off so 
you aren't distracted by the red and 
green squiggly lines as you are fe-
verishly typing your masterpiece. 
 
If you want to turn off the red and 
green squiggly underlines you need 
to click the Office button, choose 
Word Options, and then click Proof-
ing. You can then change the set-
tings to turn off the spelling and 
grammar checking that normally 
occurs as you type.  
 
In particular, you should make sure 
that two checkboxes are cleared: 
Check Spelling As You Type and 
Mark Grammar Errors As You 
Type. 
 
 
WordTips is your source for cost-
effective Microsoft Word training. 
(Microsoft Word is the most popular 
word processing software in the world.) 
This tip (6085) applies to MS Word 
versions: 2007 
 
More tips can be found at: 
http://word.tips.net/ 

 

CHANGING GRIDLINE COLOR 
 

Summary: Gridlines are very helpful in 
seeing where cells are located on the 
screen. You are not limited to black grid-
lines; here's how to change them to a 
color of your choosing.  
 

The gridlines help you track information 
on the screen easier and to locate cells 
quickly. Normally the gridlines are 
shown in black, but you may want to 
make them some other stylish color. If 
you want to change the gridline color, 
follow these steps if you are using Excel 
2007: 
 

1.  Click the Office button and then click 
Excel Options. Excel displays the Excel 
Options dialog box. 
2.  At the left of the dialog box click Ad-
vanced. 
3.  Scroll through the options until you 
see the Show Gridlines check box; se-
lect it. 
 

Click the Gridline Color control and 
choose a color you want to use for the 
gridlines. 
 

1.  Make sure the Show Gridlines check 
box is selected.  Click on OK. 
 

If you are using an older version of Ex-
cel, follow these steps instead: 
 

Choose Options from the Tools menu. 
You will see the Options dialog box. 
 

1. Click on the View tab. 
2. Use the Color drop-down palette to 
select a color for your gridlines. 
3. Make sure the Gridlines check box 
is selected. Click on OK.  
 

You can specify different gridline colors 
for each worksheet in a workbook. 
 

(This tip works with Microsoft Excel 97, Excel 
2000, Excel 2002, Excel 2003, and Excel 2007. You 
can find a version of this tip for the ribbon inter-
face of Excel (Excel 2007 and later)   
 

Source: http://excel.tips.net/ 

. 

 

INTERNET EXPLORER 9 DEBUT 
 

Today's websites and browsers 
only use about 10% of the proc-
essing power your PC has to 
offer. Internet Explorer 9 unlocks 
the other 90%. With Internet Ex-
plorer 9, we're tapping into your 
graphics processor through Win-
dows to harness the full potential 
of your PC.  
 

It makes HD video smoother, 
colors truer, graphics clearer, 
and websites more responsive. 
Combined with our new 
JavaScript engine, the web now 
performs like an application in-
stalled directly on your computer. 
 

We've also added several ways 
to reduce the number of clicks it 
takes to get where you're going. 
You can pin your favorite sites to 
your task bar for single-click ac-
cess. Our new tab pages fea-
tures your most commonly 
viewed sites.  

 

And we've moved all notifica-
tions to the bottom of the page 
with clearer instructions. Com-
bined with performance en-
hancements, these new features 
make your web browsing experi-
ence truly fast. 
  

Using Internet Explorer 9, you 
can pin sites like Hotmail, CNN 
and Facebook to your taskbar 
and then launch them like an 
app. To pin, just grab the tab in 
the browser and drag it to your 
taskbar.   
 

Source: CNN NEWS 9/19 @ 12pm  
 

Microsoft:  
http://www.beautyoftheweb.com/#/

download/thank-you 
 

 

http://www.cheapstingybargainsl.com/
http://wordribbon.tips.net/Pages/T006085_Turning_Off_Error_Marking.html
http://wordribbon.tips.net/Pages/T006085_Turning_Off_Error_Marking.html
http://word.tips.net
http://excel.tips.net/Pages/T002736_Changing_Gridline_Color.html
http://excel.tips.net/Pages/T002736_Changing_Gridline_Color.html
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~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~ ~  
Cool, Useful, Fun Freebie - PDF Viewer to Go  

by Kim Komando @ http://wwwKomando.com 
 

Are you looking for a small, capable PDF viewer? This free program is a PDF document viewer and 

printer.  It includes an interactive form filler, JavaScript support, add-on downloads, and more. You can 

now make notes on PDF documents. You can also convert PDF files to text files. 

 

Pound for pound, Foxit Reader makes for a decent substitute of Adobe Reader. It is only 1.5 MB in-

stead of Adobe's 20 MB file size. Link: www.foxitsoftware.com 

And Foxit has a fast-launch feature as well. Now you don't have to deal with an annoying splash page.  

      

 

 

 

   

 COMPUTER LINKS 

www.pluggedin.com/ 

http://www.word.mvps.org/ 

http:www.AutomaticSave.htm 

http://www.nytimes.com/2010/08/30/ 

Doug McIver………………...P.C. Defense 

Harry Hinz……………………T-Shirt 

Nancy Hinz…………………...Windows  7 Book 

Eileen Bryan…………………..50/50 

September  Door Prize  

Winners 

http://www.foxitsoftware.com/pdf/rd_intro.php
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Bearly Bytes 

Big Bear Computer  

Club Newsletter 

P.O. Box 645 

Big Bear City, CA  92314 
909 878-5822 

www.bigbearcc.org 

 

                  
  

□ New                                                □ Renewal                                 □ Update 

Information 

 

 Full Name_______________________________________________________ 

 

Mailing Address___________________________________________________ 

 

City, State, Zip_______________________ _____________________________  

 

Home Phone____________________ Cell Phone_________________________ 

 

E-mail address_____________________________________________________ 

 

Birthdate:  Month & Day:    ________________ & Associate:_______________ 
 
Family Member(s) Associates $5/year 

 

Name______________________________ E-mail________________________ 

 

DUES ARE DUE IN JANUARY 

 

Membership dues ($25.00 per person) are now being accepted by the 

Big Bear Computer Club. Be sure to pay your dues now in order to con-

tinue receiving the monthly newsletter.   You can pay your dues at the 

monthly meeting, or by mail to: Big Bear Computer Club, PO Box 645, 

Big Bear City, CA 92314; or by Pay Pal (Go into our website 

www.bigbearcc.org and go to ―Donate‖.  This will take you to Pay Pal.) 

Monthly Meeting with: 

Presentation and demonstra-

tion of popular hardware 

and software; RAM (Q & 

A) Sessions; Tech news and 

Virus Alerts 

Member Software Raffle 

50/50 Drawing 

Bearly Bytes -- Our award- 

winning monthly newsletter 

mailed to you first class. 

Club Website: 

www.bigbearcc.org 

Free software review  

program 

Members Help Line 

Members E-mail  

Notifications 

Members only Discounts 

Special Interest Groups 

(SIGs) 

All this for only $25 per 

year!! 

Mail your application  

and dues to: 

BBCC Treasurer 

PO Box 645 

Big Bear City, CA 92314 

or  
bring your application to a 

meeting. 

Or 
click here to use 

Pay Pal 

 

BIG BEAR COMPUTER CLUB, INC. 
 

Membership Application—$25.00 

Membership Benefits 

http://www.bigbearcc.org
http://www.bigbearcc.org/
http://www.paypal.com/

